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WORKING WITH DIGITAL IMAGES EFFECTIVELY  
 
This document highlights key issues regarding digital image submissions to books, magazines, galleries, 
and any exhibition opportunity. It is a supplement to the Professional Guidelines documents:  

• TOP TEN TIPS for Getting Into a ……Juried Exhibition, Craft Show, Book or Magazine 
• Guide to Professional Quality Images  

 
These Professional Guidelines documents are checklists or guides to review and critically 
evaluate the digital photography of your art or craft. For in depth instruction, there are many fine 
books, classes, and online tutorials where you can learn more comprehensive information that 
can assist you in getting amazing quality images. See the Resources for Legal and 
Professional Advice for some suggestions. 
 
Immediately below are definitions for terms used in this document: 

JPEG will be used to denote .jpg and .jpeg. 
JPEG is a file extension used specifically for images. 
JPEGs are  compressed images and subsequently (smaller) files. 
JPEGs can contain millions of colors. 

TIFF will be used to denote .tif and .tiff.   
TIFF is a file extension used specifically for images.  
TIFFs are uncompressed image files. 
TIFFs can contain millions of colors. 

GIF will be used to denote .gif. 
GIF is a file extension used specifically for images. 
GIFs are compressed image files. 
GIFs contain only 256 colors. 
GIFS are the only extension that support animated images which may include multiple or 
automated imagery.  

PSD will be used to denote .psd. 
PSD is a file extension for images used only in Photoshop. 
PSDs are uncompressed image files.  
PSDs can contain multiple layers and millions of colors. 

RAW will be used to denote .raw 
Camera RAW image files contain the actual data captured by the sensor without any in-camera 
processing; these are the only files containing “pure” data. Working with camera RAW files gives 
you maximum control; you can set the white balance, tonal range, contrast, color saturation, and 
sharpening. Think of camera RAW files as your photo negative or original slide. You can reprocess 
the file at any time to achieve the results you want.   
  
To create RAW files, you need to set your camera to save files in its own RAW file format. 
RAW creates the largest possible image in your camera. 
Book publishers often ask for RAW files to avoid amateur quality Photoshop modifications.    

RGB vs. CMYK define the specific color space of a document. By assigning, or tagging, a document 
with a profile, the application provides a definition of actual color appearances in the document.  

RGB is for web/screen viewing and the camera’s original format. RGB stands for the colors of light: 
red, green and blue. 

 CMYK is for print.  CMYK stands for the ink colors cyan, magenta, yellow and key(black) 
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I Some Digital Image Fundamentals 
 

A Computers and Software 
1 To work with digital images, you’ll need a digital image editing software application such as 

Photoshop or the more basic, and less expensive, Photoshop Elements.  Photoshop Elements 
offers fewer “bells and whistles” and tricks but will allow the user to resize and adjust images: 
which are the features that most artists need to effectively process their images.   

2 Most software applications work with either Mac or PC, but ALWAYS check FIRST for 
compatibility with your computer. Software applications are available online or in computer, 
office supply and art stores.  

3 If you are serious about your career in the arts, take a class in Photoshop or digital photo editing. 
As a student you not only learn about the software, but can buy the student version at the book 
store at a much lower cost. This will save you lots of money. 

4  Online tutorials are available: www.lynda.com is an excellent resource.  
5  Knowing how to work with digital images effectively is rapidly becoming an indispensible and 

basic necessity of maintaining a career in the art or craft fields. 
 

B Choosing the Right Resolution for Different Media - a quick review (Resolution is measured in 
dpi --dots per inch.  The higher the dpi, the denser and richer the image.) 
1 Print media (books, magazines, etc.) require high quality, high resolution digital images.  

a Minimum of 300 dpi  
b File size is usually several MB (megabytes) at this dpi.  One MB equals 1000 KB (kilobytes)   

2 Web and email images are typically lower resolution, smaller file size images.  
a Usually 72 dpi 
b File size is normally less than one MB 

3 Very large files (usually over 2 MB) can overwhelm some email systems or cause other 
problems. Reserve high resolution images for print media. It is wise, at this time, to send 
several smaller emails (under 10 MB) rather than one large one which will often get returned.  

4 The difference in image resolution may not be obvious on your computer screen, so learn to look 
at the image size and resolution when working with digital images.  In Photoshop check image 
resolution in the menu tool bar under Image>Image Size. 

 
C Scanning existing print images 

1 Quality digital images, such as those intended for publication, should not be created by scanning 
printed images.  Scanning a printed image would be creating a third generation image (a 
picture, of a picture, of a picture.) You may even pick up blemishes, a pixilated appearance or 
artifacts from the printing process. 

2 Scanning prints can be used for archival records which are not intended for print.  
 

D Creating digital images from slides or  transparencies 
1 Scanning slides for digital images will always, by definition, yield a 2nd generation image.  

a Your original slides or transparency will make the best print quality image for books or 
magazines if the publisher is willing to work with your original slides or 
transparencies.   

2 Consider having your slides or transparency (4” x 5” or 2¼” x 2¼”) professionally scanned.   
a Quality of even professional slide scanning can vary widely in quality.    

• To find a business that specializes in slide scanning look in the phonebook or go on 
line. When you talk with them ask them if they color correct the scans, or clean off dust 
before scanning. Look for the best quality, not the cheapest slide scans. It is worth it.  

• Get the largest digital file possible for your needs (30-40 MB file is the largest size 
needed for printing up to 9”x14”). 

• Costs range from $0.70 to $20 per slide depending on the file size needed, number of 
slides scanned and the lab’s scanning equipment. 
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3 Consider buying a dedicated slide and film scanner. 

a Consumer level scanners with adapters do not do a good enough job. Even the 
dedicated slide scanners sold to the average consumer are not good enough. The images 
require a lot of “tweaking” post scan.  
b Higher quality, dedicated slide scanners can cost over $1000.00.  To decide which 
model to buy ask photo students, your photographer or local businesses what they 
recommend. Do your research. Once you know what brand and model then it can simply be 
a matter of finding a new or used model. 
c Andy Cooperman suggests a Nikon Coolscan 5000 ($900 on eBay, 2007.)  He used it 
to scan not only his work but also the tons of technical slides he’s amassed over the years. 
His default scan parameters for “master scans”:  20 MB TIFF files at 4000 dpi.  These 
master scans are stored in a digital archive on an external hard drive (saves space on the 
computer’s main hard drive). He said, “A new Nikon Coolscan 5000 is selling for $1050 on 
Amazon (2009) without the slide feeder which I paid $200 for which now sells for $300 or more. 
They are about that same price on eBay Buy It Now.” 
 

E Make sure your image is sharp, not fuzzy or out-of-focus.  
1 Sometimes this is hard to tell on a computer screen looking at a small image.  
2 Double check your images by looking closer, and closer on your computer monitor, magnifying 

the image to check focus. One or two magnifications should reveal any blurry edges. Compare 
images to become familiar with what a high resolution, focused image should look like. 
Computer commands to magnify an image: 
a Mac:  CMD +   
b PC:  CTRL +  

F Printing your digital images. 
1 RGB is for web/screen viewing but some digital printers use RGB, so it always best to ask which 

format they prefer.  
2 CMYK is for print. Don’t convert your images to CMYK unless instructed to do so by the printer. 
   Converting to CMYK results in lost data unless your Photoshop Layers are flattened first.   
 

G Colors may differ in appearance on different monitors or when projected 
1 The biggest problem is that projected digital images do not appear the same when projected as 

they appear on your computer screen, nor will they always be consistent from projector to 
projector or computer to computer.  

a This is totally out of your control when you submit your images to a jury review.  
b  This problem is also very frustrating when delivering lectures. Some artists have even 
invested in their own small digital projector which they bring, along with their laptop. This gives 
them ultimate control when projecting images. 

2 Calibrate your computer monitor frequently.   
a Grays should be seen as gray, NOT milky or yellow or blue.   
b Proper calibration of your monitor will give you an accurate picture of your digital image and 

reduce the chances that your images will get passed over due to poor color quality.   
c Use the Help menu on your computer for instructions on calibrating your computer.  

• If you have installed Photoshop on Windows (PC), look for Adobe Gamma software 
(installed with Photoshop) to create a monitor profile.  

• On Mac you can use the Display Calibrator Assistant under System 
Preferences>Displays>Color to create an accurate monitor color profile.  

• In addition, there are hardware-based utilities that you can use to create an accurate 
monitor profile. Be sure to use only one calibration utility to display your profile; using 
multiple utilities can result in incorrect color.      
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II Digital images (like film) are best when shot professionally   
A Unless you are already a skilled photographer (or are willing to commit large amounts of time 

and money to become proficient in digital photography) invest in professional quality 
photography for your artwork. If you consider yourself a professional artist or craftsperson, then 
you should always have professional images ready. (Read the document Guide to Professional 
Quality Images). 

 
B Be sure to select a photographer who specializes in shooting your media and scale.  For 

instance, does your photographer have: 
1 Experience with small scale photography for small sculpture and jewelry? 
2 Experience with larger work for sculpture, site specific work or installations? 
3 Experience with media specific issues such as: 

a Shiny or reflective surfaces? 
b Texture? 
c Color? 
 

C Lighting is the key to obtaining quality images. Professional photographers have professional 
quality lights and equipment and years of experience in using them. Their expertise can capture 
the qualities that make your work special and that are so vital to communicate.  

 
III Owning a digital camera does not make you a photographer. 

A Consumer level digital cameras don’t necessarily take professional quality images suitable 
for  juries, galleries, or publications (despite multitude of features and the relative ease of taking 
photos.)  

 
B Despite a camera’s “fool-proof” automatic settings and professional capabilities, fully 

understanding their use and selecting the appropriate professional settings is another thing 
entirely.   
1 Learn to independently control F-stop, shutter speed, and depth of field.  
2 Learn to use the macro setting or appropriate lenses for close-up images and turn off the flash. 
3 Professional quality equipment is necessary for professional quality photos.  
 

C Great images start with the mechanics of photography. Don’t assume that you can fix poor 
quality images in Photoshop.  

 
IV Shooting digital images 

A Always shoot the highest resolution or largest size digital images that your camera will allow. 
 
B Take photos with your camera in RAW format if possible. RAW digital formats capture the 

most information.   
 
V Using your scanner to create a “quick” digital image (not intended for 

publication or jurying.) 
 

A  Quality flat bed scanners will scan small, relatively flat art or craft. 
1 Experiment with different backgrounds. 
2 A plain white piece of (unprinted) glossy photo paper works very well. 
3 Try covering small objects or jewelry with a white plastic Tupperware® bowl. 
4 For work larger than your flatbed scanner you can combine multiple scans together using 

Photoshop. 
a CLICK File>Automate>Photomerge 
b SELECT files that you want to merge 
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B Using your flatbed scanner for 3-dimensional work is not a substitute for professional 
quality photography. Digital scans are primarily useful for special circumstances such as:   
1 Client communication 
2 Quick documentation 
3 Lecture images 
4 Design tool (Andy Cooperman says “I will stick elements together with wax, scan them and then 

rearrange things and rescan. I print out in black and white and then compare scans side by side. 
Great way to work out design solutions.”) 

 
C Scans – and all digital images--may need brightness or color adjustment to appear 

accurate. 
 

D Professional quality scans by businesses specializing in scanning 2-dimensional work can 
produce amazing high fidelity, high quality images that are an appropriate substitute for 
photography. 
1 Harriete Estel Berman says “I had a flat, 2-dimensional tin can metal collage professionally 

scanned for a printed image instead of photographed. The image was so amazingly crisp you 
would have sworn that you could see the dimension of a tiny rivet. “  

2 Look for business that specializes in scanning 2-dimensional artwork. 
 

VI Digital Images Intended for Publication in Print Media 
  

A Some characteristics of a good, high quality digital print image: 
1 High resolution 300 dpi (dots per inch) or higher 
2 Large pixel dimensions (height and width).  

a Example: 2400 x 3600 pixels;  
b Example: a 4”x 6” image should be 1200 x 1800 pixels. 

3 The least amount of image compression (TIFF or RAW) 
4 Check the file size on your computer. File size should be in MB (megabytes).Example 25MB 

a “Properties” will show file size. 
b  Highlight and right CLICK on a PC to show file size. 
c  Hover your mouse over file name on a PC to show file size.   
d  Open image in Photoshop (or photo editing software) to see file size.  
e  On the Mac, highlight the file and then press the “command” and “i” keys to get file  

information 
5 TIFF files are preferred for print.  

a Saving files in TIFF format is the only way to completely prevent data loss when the file is 
opened and saved again. 

6 RAW files are the best high quality option. 
7 JPEG files may be acceptable for print if the file is a high resolution, high quality image. 

a JPEG image files are less desirable for print because every time the file is saved or resaved 
data is lost. 

b To reduce the amount of data that is lost, select the highest quality setting when saving the 
file. 

c If many edits need to be made to a JPEG file, consider saving the image as a TIFF from the 
start and then convert back to JPEG if necessary.  

d Consider creating a TIFF archive from which you produce smaller jpegs as needed. 
8 PSD is the extension for files saved in the native Photoshop format.  

a PSD files are generally very large in size and can only be opened in Photoshop. 
b It is not good practice to send PSD files to other people since they will not be able to open 

them without Photoshop. 
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B Images for printing in books and magazines: 
1 Always ask and follow the instructions of the book printer or publisher.  Do not expect them to 

accept images in formats other than what they tell you they want. 
2 Do not compress JPEG or TIFF formats when the images are intended for print. 
3 Avoid Photoshop-ing your images unless you are very experienced in photo editing.  

a Below are recommendations regarding Altering Images from Lark Books. 
• Do not alter images on a computer after you take them. Send the original version that 

comes from the camera.    
• Do not adjust images to look nice on your monitor.  Adjusting images (color, levels, 

curves, etc) will cause data loss. The publisher adjusts images for 4-color printing. A 
press-ready image viewed on screen looks shockingly dark, saturated, and sharp. If you 
send an image adjusted for pleasing screen viewing it probably will not print well. 

• Do not manipulate or "correct" the images in any program: DO NOT "PHOTOSHOP." 
• DO NOT SILHOUETTE, or remove backgrounds. 
• DO NOT RUBBER STAMP or ERASE any part of image. 
• If image needs alteration, write instructions on printout and the publisher will determine 

whether alterations should be made by prepress technicians. 
4 RAW FORMAT 

For print media, publishers may prefer digital images in RAW data format.  
a RAW data is your camera's native file format.   

• Different camera manufacturers use different extensions for RAW files, such as CRW 
and NEF (refer to your manual). 

b Unlike JPEG or TIFF formats, which filter or reduce image data, RAW files hold every bit of 
information about an image that your camera's computer chip can produce. Such complete 
information assures the best possible printing. 

 
C Distributing large digital files. Always send the largest digital file possible or the size 

specified by the publisher.  
1 Send large files by: 

a Copying files to a CD, protecting them in a CD sleeve or plastic case and then sending them 
by regular mail, Fed Ex, etc.  

b Uploading to specialized websites that handle large files for storage, and sending an email 
link to the recipient (yousendit.com is a great one to use). 

c Uploading by using FTP service to a server. (Usually this is a fee based service or software 
downloaded to your computer.) 

 
D If you are sending both JPEG (for web) and TIFF (for print) on a CD, organize your images in 

different 'folders' for each media or entry.   Label each file distinctly and unambiguously for the 
publisher.   
1 Web folder: JPEG files, 72 dpi, 800-1000 pixels on largest side (for web/computer screen 

viewing)  
2 Print folder: TIFF files, 300 dpi (or higher), largest dimension possible (for printing).    

 
VII Distributing Digital Images for Other Purposes 

A Use smaller resolution Images for web-only, email, or non-print purposes.  
1 Images for email or web viewing: 72 dpi, maximum of 800 pixels horizontally or 600 pixels 

vertically. 
2 Images for PowerPoint or Keynote presentations: 1024 pixels on the largest side.  
3 However, state in your supporting materials that better quality, larger files are available for print. 

If you are prepared with high quality, large digital images your work may be featured on a book or 
magazine cover!   
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B Sending digital images by email. 
1 Be careful about emailing a large number of images to a gallery or professional acquaintance 

without asking first. Ask before sending large 1MB -2MB digital images by email. 
2 Large files (2 MB) or a lot of smaller images (equal to 2MB) tend to fill up the recipient's mailbox. 

This can be so annoying that you may lose an opportunity.    
 

C Sending digital images by mail.  
1 Unless instructed otherwise, mail a clearly labeled CD of images along with:   

a A description sheet of the images. The description for each images should include: 
• Title 
• Date for art or craft 
• Artist’s complete name 
• Brief description of materials/medium/techniques 
• One sentence to describe function, movement or content, in necessary. 
• Dimensions  (height x length x width) 
• Photo credit for images. 

b Contact sheet print (see IX below for more information) 
c Bio or resume (1-5 pages maximum.) 
d Artist statement (300 words or less.) 
e Cover letter with your contact info  
f SASE (Self Addressed Stamped Envelope ) if you want the materials returned.  Do not 

expect your materials to be returned without at SASE. 
2 The above information should also be on the CD as a Word or PDF file (in case they want a 

digital copy of the text). 
 

D Naming digital images for distribution.   
1 Name files with a number first, then your last name plus first initial, then abbreviated title or 

description. Example: 01_BermanHear.tif or  1BermanHneck.tif 
2 This way all files will reorganize themselves on the CD or on another computer as a group in the 

order you prefer.   
3 If your last name is long, use the first three letters or your initials. 
4 No spaces or characters other than a period (.) or an underscore (_) in the file name. 

a Example:  bermanh.greenbr.doc 
b Example:  bermanh_greenbr.doc 

5 Keep the file name as short as possible. 
 

E   Avoid opening JPEG files to just rename them.  Simply opening and closing a file won’t lose 
information but opening a file, renaming and then saving or resaving it will.   
1 PC: Highlight the file name with RIGHT CLICK.  

a CLICK Rename   
b Rename file without opening 

2 Mac:  Slowly click once on the file name and again until the name is highlighted by a blue box.  
a Rename 
b Be careful not to change the file extension (.jpg, .tif, etc).  Information can be lost by saving 

any changes. 
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VIII Submit Digital Images with a CONTACT SHEET.   
If you are sending a CD of your images, include a printed Contact Sheet (labeled thumbnails of the images 
on the disc). 
 

A To make a Contact Sheet:   
1 Make sure all your images are in ONE FOLDER.  
2 Label the images following the recommendation above in Section VII, D. 
3 OPEN Photoshop 

a File> Automate>Contact Sheet II 
b Select your source folder. 
c Decide on the thumbnail layout, choosing the number of rows and columns. 
d Click, Use Filename as Caption (optional). 
e Print on photographic paper for the best quality images. 

 
B  View a Sample Contact Sheet in the Appendix at the end of this document.  

 
IX Submitting Digital Images for Jury Submission 
 

A When sending digital images for a jury, always follow the instructions exactly.   
1 Do not exceed the file size or resolution requested. 
2 Send files only in the format that is requested (JPEG, TIFF, etc). 

 
B Digital image review is often at 72 dpi. This is because computer monitors have only 72 lines or 

picture elements per square inch. This is a relatively small file that can be easily sent via email. 
 

C Digital photos of your work require even more 'pop' than with film images.  Since web-
formatted images have such low resolution (72 dpi), much of the detail has vanished.  Be sure to 
shoot many views to assist a viewer in understanding all details of your work, if possible.  
1 Usually you are only allowed one full view and a detail for a book or jury submission.  Harriete 

Estel Berman suggests that you shoot multiple close-ups because sometimes it is hard to tell 
which will be the most successful close-up at the time of the photo shoot. Having a number of 
detail shots allows you to select the best possible image to submit. 

2 Multiple close-up shots are great for web sites or lectures. 
 

D Submit the highest quality format accepted. If possible, 300 dpi, 4”x 6" minimum, in the form of 
JPEG (compressed), or better TIFF (uncompressed).  

 
E Check which color mode is preferred:  RGB (web), or CMYK (print). If not specified use RGB.   

 
F Do not submit an animated GIF file or “slide show”. Still images (non-animated) are best with 

lots of details. If you send an animated GIF, the jurors cannot control how long they look at one 
image before it changes to another image. They are forced to view your work in the time frame of 
the animation. 

 
G Keep your images for digital jury review simple and unembellished.  LET THE WORK 

SPEAK FOR ITSELF. 
1 Do not create a “collage of your work” in one image for jury review. 
2 Do not highlight images of your work with colored or decorative frames. 
3 Do not put colored backgrounds around an image. 
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H If submitting images to an online jury service (such as Zapplication, or callforentry.org), follow 
the instructions exactly.  
1 Horizontal format for images may have an advantage in these circumstances because monitors 

and projection screens are horizontal.  A larger horizontal image tends to look more dramatic 
than a vertical image because it fills the entire screen.  

2 Some online jury services are asking that all submitted work be of a specific size for this reason. 
Pay attention to digital, online review requirements AND FOLLOW THEM. 

 
I If your work is accepted for any show, exhibition, book or magazine, follow-up with larger, 

print quality digital images (300 dpi) by sending the image on a disc by USPS mail. Discs are 
inexpensive and well worth their use as “redundant” media.  
1 Create new opportunities for your work by always being prepared with top quality, large print 

quality images. Refer to the document Guide to Professional Quality Images in the 
Professional Quality Images.  

2 Send these images immediately. Publications deadlines are always “yesterday, it is the nature of 
print media.   

 

*****************************************  
SNAG Professional Guidelines Committee 
©2009 Harriete Estel Berman, Chair 

Special appreciation to the Professional Guidelines Committee, including editor and writer Andy Cooperman, 
Emiko Oye for technical review and Margot Placeman for review. 

 
DISCLAIMER 
 
"THE SOCIETY OF NORTH AMERICAN GOLDSMITHS AND THE COPYRIGHT OWNER HAVE PREPARED THE 
FOLLOWING MATERIALS AS AN INFORMATIONAL AID TO EDUCATE THE READER ABOUT COMMON 
SITUATIONS THAT GENERALLY ARISE IN THE ARTS AND CRAFTS FIELD. THESE MATERIALS, INCLUDING 
ALL SAMPLE AGREEMENTS, CANNOT AND DO NOT ADDRESS ALL OF THE LEGAL ISSUES THAT MAY BE 
PERTINENT TO ANY INDIVIDUAL CIRCUMSTANCES. THE READER SHOULD NOT ASSUME THAT THE 
INFORMATION CONTAINED HEREIN WILL SATISFY ALL OF THEIR NEEDS. LAWS VARY FROM STATE TO 
STATE, AND THESE MATERIALS ARE NOT A SUBSTITUTE FOR OBTAINING LEGAL ADVICE FROM A 
LICENSED ATTORNEY IN YOUR STATE. THE READER IS ENCOURAGED TO SEEK SUCH LEGAL ADVICE 
PRIOR TO USE OF THESE MATERIALS. SNAG AND THE COPYRIGHT OWNER DISCLAIM ANY 
RESPONSIBILITY FOR ANY AND ALL LOSSES, DAMAGE, OR CAUSES OF ACTION THAT MAY ARISE OR BE 
CONNECTED WITH THE USE OF THESE MATERIALS AND/OR FORMS." 

************************************************************* 
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Appendix  
Sample Contact sheet (to accompany disc of digital images).  
Read   VIII Submit Digital Images with a CONTACT SHEET for Step by Step instructions. 
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	These Professional Guidelines documents are checklists or guides to review and critically evaluate the digital photography of your art or craft. For in depth instruction, there are many fine books, classes, and online tutorials where you can learn more comprehensive information that can assist you in getting amazing quality images. See the Resources for Legal and Professional Advice for some suggestions.

